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1 
Introduction to the release notes

This documentation covers installation steps, software changes, and known issues for Dolby Atmos
Renderer v3.7.

• About this documentation
• Contacting Dolby

Introduction to the release notes
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1.1 About this documentation
This documentation is for engineers, sound designers, and others who install or use Dolby Atmos Renderer
software for editorial, pre-mix, and sound design workflows when authoring sound for digital home theater,
music, or VR, and creating Dolby Atmos masters.

Note: This documentation also includes a list of features and improvements added in recent previous
versions. For complete information about these features, see the Dolby Atmos Renderer Guide .

1.2 Contacting Dolby
You can contact Dolby regarding this product and its supporting documentation.

If you have technical questions about this product, contact your reseller and/or visit https://
professionalsupport.dolby.com.

If you have questions or comments about this documentation, please send an email to
documentation@dolby.com.

About this documentation
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2 
New in this version

This version of Dolby Atmos Renderer includes new features, improvements, and fixes, as well as
updates included in previous versions.

• New in version 3.7

New in this version
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2.1 New in version 3.7
Dolby Atmos Renderer v3.7 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

macOS Big Sur 11.5 support
Dolby Atmos Renderer v3.7 is supported on Intel-based Macs running macOS Big Sur 11.5. Renderer v3.7 is
compatible with macOS Big Sur 11.5 on M1-based Macs (with Rosetta 2), although you may experience
performance issues as Rosetta 2 is a translation layer between the application and the ARM processor. Before
upgrading to Renderer v3.7 on an M1-based Mac, ensure that all required drivers for audio I/O and license
authentication (iLok) are M1 compatible.

Dolby Audio Bridge v2.0
Dolby Audio Bridge v2.0 automatically clocks to output hardware. This eliminates the workaround of using
an aggregate device to ensure proper clocking.

This new version of the Dolby Audio Bridge virtual driver is included in the Renderer installer package, and
should be selected when doing the installation. v2.0 overwrites the version of the bridge included with
earlier versions of the Renderer. Aggregate devices created with Dolby Audio Bridge v1.0 will no longer be
active.

Installation of Dolby Audio Bridge v2.0 does not require a restart of the computer.

Note: Installation of v2.0 automatically deletes Dolby Audio Bridge v1.0 from your computer.

Figure 1: Dolby Audio Bridge v2.0 installed

New in version 3.7
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Important: If you install an older version of the Renderer, do not install the Dolby Audio Bridge v1.0
(no icon) included with the older installer package. Dolby Audio Bridge v2.0 (with icon as shown)
should be the only bridge on your system. v2.0 of the bridge will work with Renderer v3.5 and earlier,
except that aggregate devices are still required for certain workflows.

Support for Dolby Atmos Binaural Settings plug-in v1.1 in multiple plug-in formats
Dolby Atmos Binaural Settings plug-in v1.1 for Mac is now included in the installer as an optional install, in
these formats:

• Avid Audio eXtension (AAX)
• Apple Audio Units (AU)
• Virtual Studio Technology (VST3)

Installation includes Dolby Atmos Binaural Settings plug-in documentation.

Important: For workflows that use the Dolby Atmos Binaural Settings plug-in, Renderer v3.7 requires
Dolby Atmos Binaural Settings plug-in v1.1. Renderer v3.7 does not support Dolby Atmos Binaural
Settings plug-in v1.0.0 and earlier.

UI update: The Binaural Settings plug-in now indicates unassigned objects, via a yellow outline.

MTC support removed
The Renderer no longer supports MTC (MIDI Time Code). We recommend using linear timecode (LTC) over
audio for all workflows that require synchronization. See Support for Dolby LTC Generator v2.0 in multiple
plug-in formats .

User interface (UI) changes:

• In the Driver preferences, the External sync option no longer includes MTC as an option.
• The Audio to timecode alignment window no longer includes MTC offset options.

Support for Dolby LTC Generator v2.0 in multiple plug-in formats
Dolby LTC Generator plug-in v2.0 is required for synchronizing the Renderer to LTC over audio from a DAW on
a system using the Dolby Audio Bridge.
Dolby LTC Generator v2.0 for Mac is now included in the installer as an optional install, in these formats:

• Avid Audio eXtension (AAX)
• Apple Audio Units (AU)
• Virtual Studio Technology (VST3)

The AAX version of Dolby LTC Generator plug-in v2.0 is contained in Pro Tools templates included with this
installer.

Important: Older Pro Tools templates containing Dolby LTC Generator plug-in v1.0 must be manually
updated to use v2.0 of the plug-in.

Note: Nuendo and Resolve have timecode generators. The Nuendo templates provided by Dolby
include a track with a Steinberg SMPTEGenerator plug-in inserted on it.

Depending on the DAW or plug-in format, the plug-in displays synchronization information or provides
controls for synchronization settings.

For DAWs such as Pro Tools and Nuendo, which have a configurable frame rate and start time, the plug-in
window provides synchronization information.

New in this version
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Figure 2: Dolby LTC Generator plug-in v2.0 in Pro Tools

For DAWs such as Ableton Live and Logic, which do not have a configurable frame rate and start time, the
plug-in window provides synchronization controls.

Figure 3: Dolby LTC Generator plug-in v2.0 in Logic

Frame rate drop-down menu or display
This is the frame rate of the DAW, which should match the frame rate of the Renderer. For a DAW that
does not have a configurable frame rate, set the frame rate in the plug-in window. For a DAW that has a
configurable frame rate, the plug-in displays the frame rate set in the DAW. For example, in Pro Tools, this
is the Timecode Rate, which is set when you create the session, or can be set in the Pro Tools Session
Setup window.

Start time field or display
This is the start time of the timeline. For a DAW that does not have a configurable start time, set the start
time in the plug-in window. For a DAW that has a configurable start time, the plug-in displays the start
time set in the DAW. For example, in Pro Tools, this is the Session Start, which is set in the Pro Tools
Session Setup window.

Output display
This is the timecode position that the Dolby LTC Generator plug-in outputs. The position will be in sync
with the DAW transport timecode values.

New DAW templates and presets configured and ready for Dolby Atmos authoring
The Renderer v3.7 installer includes new or updated DAW templates and presets.

• New templates: Nuendo 10.3, and Nuendo 11
• New presets: Resolve Studio 17 Fairlight
• Updated templates: Pro Tools and Nuendo 10

New in version 3.7
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Note: Before using a Nuendo template or Resolve preset provided by Dolby, refer to information
regarding using the template or preset.

Pro Tools session templates using the Dolby Audio Bridge now include one track with a Dolby LTC Generator
plug-in inserted on it (whether or not LTC is used from the plug-in or from external hardware.). The input/
output (I/O) settings file is configured to route the LTC over audio signal to the Renderer for synchronization
on channel 129.

Note: Ensure that you install the LTC Generator plug-in, so that it is available for use with the
template. The plug-in is included in the Renderer installer.

Warning: Ensure that the signal from the Dolby LTC Generator is not output to a speaker.

Frame rate improvements
• The default frame rate for the Renderer has changed to 24 fps.

The Renderer frame rate is displayed in the frame rate readout in the Renderer main window header, and
is set in the Driver preferences.

• A frame rate mismatch error message displays when your digital audio workstation (DAW) and the
Renderer frame rates do not match. This alerts you to change either the DAW or Renderer frame rate.

Note: The message displays the first time a mismatch occurs, and should be corrected. If not
corrected, the message will not appear again, until the next reinitialization.

This message displays with a setup that uses LTC over Audio, or Send and Return plug-ins. This
message does not display with a setup using ASIO sync; if you are using a configuration with RME
MADI PCI cards, manually set the frame rate in the Hammerfall DSP application.

Multiplexing audio and video when exporting a master to MP4
When exporting a master to MP4, you can add a custom video file, include black video (Renderer v3.5 and
earlier behavior), or create an MP4 file without any video.

The Export master to .mp4 window now includes a Video section, with these options:

Black video
This option creates black video to match the length of the audio encode. This is the behavior of Renderer
v3.5 and earlier.

No video
This option creates an audio only mp4. Use this option for audio only playback devices that do not
require black video.

Custom video
Use this option to embed a custom video stream in the output .mp4. The custom video input must be an
mp4 with an h264 video elementary stream.

To ensure playback sync, ensure that the video start corresponds to the audio start or In point.

Note: If the audio and video have different lengths, a warning displays to tell you that the file will
be conformed to the longer of the two files.

When you choose Custom video, a Video file field displays. You can manually enter the file path for the
video here, or you can click the Browse button, and then locate and select the file. If no file path is
specified, the file will be exported with black video.

Bass management object mode removed from Speaker preferences
The Renderer now provides one bass management mode (speaker).

New in this version
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In Speaker preferences, the Bass management section has been renamed to Speaker bass management
and the Object mode option has been removed. The Frequency setting is for speaker bass management
only.

If you import system settings created with Renderer v3.5 and earlier, which had object selected as the bass
management mode, the Speaker preferences updates to speaker internally, and uses the frequency that was
saved with the object mode.

New shortcuts for muting speakers in the room configuration display
The Renderer main window now supports more shortcut options for muting (and unmuting) the monitor
output level of one or more speakers in the room.

• To mute one speaker only, click on a speaker icon.

Note: In earlier versions of the Renderer, this shortcut was used to mute and unmute multiple
speakers.

• To unmute a speaker and mute all other speakers, Cmd-click on a speaker icon.
• To mute multiple speakers in a selected area, click-drag over one or more speaker icons.

Note: In earlier versions of the Renderer, this shortcut was used to mute and unmute multiple
speakers.

• To mute all speakers, Cmd-click an empty area in the room configuration.
• To unmute all speaker in a selected area (drag rectangle), and mute all other speakers, Cmd + click-drag

over one or more speaker icons.
• To unmute all speakers, click an empty area in the room configuration.
• To toggle the mute state of a speaker, Cmd+shift-click on a speaker.
• To toggle the mute state of all speakers in a selected area (drag rectangle), Cmd+shift-drag over one or

more speaker icons.

Status section and Input/Master mode settings
In the bottom left of the main window, the Renderer provides status information when settings in the Input
and Master do not match. The section provides status information for these settings: input configuration,
Binaural Render mode, and trim and downmix controls.

When settings in the input differ from the settings in the currently loaded master, the settings name and an
orange light display in the bottom left of the main window. When the settings match, no status is provided.

New in version 3.7
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Figure 4: Input configuration mismatch

New in this version
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Updates for working with Input and Master mode settings
The Input configuration, Binaural Render mode, and Trim and downmix controls windows have been
updated to support displaying input and master settings, manually changing the settings, or copying settings
from the master to the input, or vice versa.

With these changes, it is now possible to play a master that has a different input configuration than what you
are monitoring live. The master no longer controls the input configuration, and will no longer mute objects
that are being monitored but are not defined, or are defined differently, in the master.

UI changes include:

• All three windows have Input and Master tabs, to view and compare the settings in the input and in the
master.

• Input settings are always editable, either from within the Renderer or a connected client (such as the
Dolby Atmos Binaural Settings plug-in).

• Input and Master pages include two copy settings buttons, to copy settings from the input to the master,
or from the master to the input. These buttons are available when the settings for the input and master
do not match, and when applicable.

Figure 5: Copy settings buttons at the bottom of an Input or Master page

When the buttons are inactive, you can hover over the button for an explanation.

Figure 6: Hovering over the Copy settings from master to input button to see why the button is
unavailable

An application reinitialization occurs when switching between the Input and Master in the main window
UI if there is a difference in input and master input configuration settings.

Note: You cannot update the channel layout (order and descriptions of beds and objects) of an
existing master file.

Downmix 5.1 and 5.1.x label
The 5.1 downmix label in the Trim and downmix window has been updated to 5.1 and 5.1.x downmix to
better clarify that the settings also apply to 5.1.x.

Note: The 5.1 and 5.1.x downmix setting is also shown in the Export re-renders and Re-renders
windows, as well as in the Override master downmix section of the Trim and downmix window.

Override master downmix control for monitoring and re-renders
By default, the settings shown in the Input page of the Trim and downmix controls window are used when
monitoring the live input, and the settings in the Master page are used when playing back a currently loaded
master.

You can monitor a master and produce re-renders with downmix settings that differ from the settings in the
master by using the Override master downmix option (which is in the Trim and downmix controls window,
Master page).

New in version 3.7
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Figure 7: Override master downmix option (enabled)

After you enable the option, select the 5.1 and 5.1.x downmix and 5.1 to 2.0 downmix settings that you want
to use for monitoring and re-renders.

Note: The Override master downmix option is not persistent. When you close the Renderer, it
defaults back to off.

The Re-renders and Export re-renders windows now display the current downmix settings, to let you know
the settings that are in use, and that will be used in exports and re-renders.

When the override settings are enabled, the display includes a yellow caution icon, and a tooltip that tells
you that the Override master downmix is active, and which downmix settings are being used. The downmix
settings being used differ from what is written in the master file.

Figure 8: Re-renders window showing downmix settings, with Override master downmix option disabled

New in this version
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Figure 9: Re-renders window showing downmix settings, with Override master downmix option enabled

New in version 3.7
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Figure 10: Export re-renders window showing downmix settings for 5.1 and 5.1.x overridden, but 2.0 kept as
in the master

Custom group and re-render names no longer case sensitive
Custom group and re-render names are no longer case sensitive. This means that you cannot have two
groups (or re-renders) named with the same characters, but different capitalization. For example, you cannot
have SYNTHPADS and SynthPads at the same time.
When importing a group or re-render name that has the same characters as the name in the Renderer, but
different capitalization, the Renderer uses the imported name.

• The Renderer uses the capitalization of an imported name when importing system settings (.atmoscfg)
or configurations for Renderer input, Binaural Render mode, and re-renders (.atmosIR, or
older .rmuio) file). For example, if the Renderer has a custom group named SYNTHPADS, and you
import a configuration that has a custom group named SynthPads, the custom group name will update
to SynthPads.

• The Renderer uses the capitalization of the Renderer default group name if you import an older master
with a custom group name that is the same, except the capitalization differs.

New in this version
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3 
Introduction to the Dolby Atmos Renderer

The Dolby Atmos Renderer provides the software components required to monitor, create, and play
back Dolby Atmos masters.

• Dolby Atmos suites and the Renderer
• Dolby Atmos Renderer installer components

Introduction to the Dolby Atmos Renderer
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3.1 Dolby Atmos suites and the Renderer
The Dolby Atmos Renderer is included in two Dolby Atmos suites: Dolby Atmos Mastering Suite and Dolby
Atmos Production Suite. Depending on the suite license, different features are provided.

Figure 11: Dolby Atmos Renderer
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3.1.1 Dolby Atmos Mastering Suite software package
The Dolby Atmos Mastering Suite package includes the Dolby Atmos Renderer, which provides the software
components required to monitor, create, and play back Dolby Atmos masters for home theater and music.

This suite is for engineers, sound designers, and others who use Dolby Atmos Renderer software for creating
and monitoring high-value complex content for home distribution (Blu-Ray, and over-the-top (OTT)) on a
multiple computer system that supports full equalization (EQ) calibration and includes a dedicated
rendering and mastering workstation for power on demand.

The Dolby Atmos Mastering Suite includes one license for Dolby Atmos Mastering Suite and three licenses for
Dolby Atmos Production Suite.

Use the Dolby Atmos Mastering Suite to run the Renderer on a rendering and mastering workstation, which is
a dedicated Mac or Windows machine with a Dolby-specified hardware configuration. Use the Dolby Atmos
Production Suite to run the Renderer in-the-box (on a single computer) to monitor, create, and play back
Dolby Atmos content in a premix or editorial workflow.

The Dolby Atmos Renderer installer includes the Dolby Atmos Renderer Remote application. This application
controls the Renderer on the rendering and mastering workstation from a computer on the same network.
The Renderer Remote application does not require a license.

Introduction to the Dolby Atmos Renderer
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3.1.2 Dolby Atmos Production Suite software package
The Dolby Atmos Production Suite package includes the Dolby Atmos Renderer, which provides the software
components required to monitor, create, and play back Dolby Atmos content.

This suite is for engineers, sound designers, and others who use Dolby Atmos Renderer software in the box
on the same computer as their DAW.

The Dolby Atmos Production Suite provides access to one license for running the software on a supported
Mac central processing unit (CPU).

Note: The Dolby Atmos Renderer Remote application, included as an option when installing the
Renderer, is used for Dolby Atmos Mastering Suite workflows only. If you are working with the Dolby
Atmos Production Suite only, you do not need the Dolby Atmos Renderer Remote.

3.2 Dolby Atmos Renderer installer components
The Dolby Atmos Renderer installer provides software for mixing and recording Dolby Atmos content.

Table 1: Renderer installer components

Component Description

Dolby Atmos Renderer This application is required to render audio and Dolby Atmos metadata from a
supported digital audio workstation (DAW). The software supports various tasks,
including monitoring a Dolby Atmos mix, and recording or playing back a
Dolby Atmos master.

Dolby Renderer Send and Return
plug-ins (Mac only)

These Pro Tools plug-ins are installed with the Dolby Atmos Renderer. They are
designed for in-the-box workflows with the Dolby Atmos Production Suite and
can be used instead of the Dolby Audio Bridge.

The Send plug-in can be used to send object or bed source audio to the Dolby
Atmos Renderer from Pro Tools. The Return plug-in can be used to receive
Dolby Atmos audio from the Dolby Atmos Renderer and then route the rendered
mix to Pro Tools outputs.

Dolby Atmos Renderer Remote
(Dolby Atmos Mastering Suite
workflows only)

This optional application enables remote control of a Dolby Atmos Renderer that
is running with a Dolby Atmos Mastering Suite license and is located on the same
network. In this configuration, the Dolby Atmos Renderer Remote on the DAW
machine controls the Dolby Atmos Renderer on the rendering and mastering
workstation.

Dolby Audio Bridge (Mac only) This optional Core Audio driver enables the rendering application to act as a
virtual Core Audio device. It supports routing audio (beds and objects) from a
DAW configured to use the bridge.

Dolby Atmos Binaural Settings plug-
in

This plug-in provides remote control of Renderer settings (Binaural Render mode
and input configuration) from a DAW session.

The Renderer installer includes these versions of the Dolby Atmos Binaural
Settings plug-in: AAX, AU, and VST3.

Dolby LTC Generator plug-in v2.0 This plug-in is required for synchronizing the Renderer to linear timecode (LTC)
sent as audio from a DAW. (By default, the Renderer listens for LTC over audio on
channel 129.)

The plug-in can also be used in Mastering Suite workflows, by using a dedicated
audio channel.

Dolby LTC Generator plug-in v2.0 is contained in Pro Tools templates included
with the Renderer installer.

Dolby Atmos Renderer installer components
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Table 1: Renderer installer components (continued)

Component Description

Documentation The installer includes user documentation for working with Dolby Atmos.

DAW templates (Mac only) The installer includes DAW templates for creating sessions (or projects) that are
configured and ready for Dolby Atmos authoring. The Renderer includes
templates for these DAWs: Pro Tools Ultimate, Nuendo 10, Nuendo 11, and
Resolve Studio 17.

Selecting the Pro Tools template option also installs Pro Tools input/output (I/O)
settings files.

Downloadable Dolby software for use with the Renderer
Dolby provides additional software and plug-ins for use with the Renderer. These are available for download,
as noted.

Dolby Atmos Conversion Tool
This tool enables you to convert one Dolby Atmos media file format to another, or perform other
conversion tool operations, such as changing the frame rate of a Dolby Atmos media file.

Dolby Atmos Conversion Tool is available at https://developer.dolby.com/forms/dolby-atmos-
conversion-tool.

Dolby Atmos Music Panner
This plug-in lets you position audio objects in a three-dimensional audio field. Additionally, the panner
includes a sequencer for syncing object positioning to the DAW tempo.

The Dolby Atmos Music Panner plug-in is available in AAX, AU, and VST3 plug-in formats (at https://
developer.dolby.com/tools-media/production-tools/dolby-atmos-production-tools/.

On Pro Tools, Nuendo, and Resolve systems, the plug-in can be used instead of DAW object panners.

Note: The Pro Tools template included with the Dolby Atmos Music Panner installer has the Dolby
Atmos Music Panner plug-in inserted on object tracks and ready to use.

3.2.1 Dolby Atmos authoring documentation
The Dolby Atmos Renderer installer includes supporting documentation.

When selected during installation, documentation for Dolby Atmos Production Suite and Dolby Atmos
Mastering Suite on Mac is installed at ~/Applications/Dolby/Dolby Atmos Renderer/
Documentation. For Dolby Atmos Mastering Suite on Windows, documentation is installed at
C:\Program Files (x86)\Dolby\Dolby Atmos Renderer\Documentation.

After installation, installed documentation is also available in the Renderer. You can access an HTML version
of the Renderer guide via the Help > Dolby Atmos Renderer Guide menu command. You can access all
Renderer documentation via the Help > Open Documentation menu command.

Dolby Atmos Production Suite and Dolby Atmos Mastering Suite on Mac include the entire documentation
set. Dolby Atmos Mastering Suite on Windows does not include the documentation noted as Mac only.

Dolby Atmos Renderer Guide
This documentation provides information for using the Dolby Atmos Renderer and other Dolby Atmos
software to create or play back a Dolby Atmos master, listen to a Dolby Atmos mix, and pan audio objects
in a Dolby Atmos mix.

Dolby Atmos Renderer Release Notes
Refer to this documentation for installation instructions, new features and improvements, and known
issues.

Introduction to the Dolby Atmos Renderer
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New in Dolby Atmos Renderer
This documentation provides a list of what is new in the release. For releases with major user interface
(UI) changes, this documentation details these changes as a primer to the main guide.

Dolby Atmos Production Suite Quick Start Guide  (Mac only)
This documentation introduces you to the Dolby Atmos Production Suite components and provides the
steps needed to install the suite and then verify your setup by playing audio from a supported DAW
session.

Dolby Atmos Renderer Third-Party Software
This documentation identifies the third-party software licensed under open-source or proprietary
licenses that is incorporated into the Dolby Atmos Renderer software, along with the required notices.

Dolby Atmos Plug-Ins Third-Party Software
This documentation identifies the third-party software licensed under open-source or proprietary
licenses that is incorporated into Dolby Atmos plug-ins, along with the required notices.

Dolby Atmos Binaural Settings plug-in documentation
This documentation is installed with the Dolby Atmos Binaural Settings plug-in.

Dolby Atmos Binaural Settings Plug-in Guide
This documentation describes how to set up and use the Dolby Atmos Binaural Settings plug-in, which
lets you remotely control Renderer settings (Binaural Render mode and input configuration) from a DAW.

Dolby Atmos Binaural Settings Plug-in Third-Party Software
This documentation provides the third-party software licensed under open-source or proprietary
licenses that are incorporated into the Dolby Atmos Binaural Settings plug-in along with the required
notices.

3.2.2 Dolby Atmos Renderer DAW templates
The Renderer installer includes DAW templates and presets for Dolby Atmos Production Suite workflows. Use
the installer to install templates and presets on the computer running the DAW.

Important: For Pro Tools setups that use the Dolby Atmos Music Panner plug-in, use the templates
and I/O settings files included with the panner installer.

Pro Tools Ultimate session templates
The Renderer installer includes Pro Tools session templates for use with Pro Tools object panners.

Pro Tools session templates and Pro Tools I/O .pio settings files for setups using the Dolby Audio Bridge and
Pro Tools object panners

Session file names are based on the system setup and use of mono or stereo plug-ins.

• Session templates are installed in a Pro Tools session templates folder (~/Documents/Pro
Tools/Session Templates/Dolby Atmos Production Suite).

• Dolby Atmos Renderer Dolby Audio Bridge Mono.ptxt
• Dolby Atmos Renderer Dolby Audio Bridge Stereo.ptxt

Note: These templates contain a Dolby LTC Generator plug-in.

• Pro Tools I/O .pio settings files are installed in the Pro Tools IO Settings folder (~/
Documents/Pro Tools/IO Settings).

• Dolby Atmos Renderer Dolby Audio Bridge Mono.pio
• Dolby Atmos Renderer Dolby Audio Bridge Stereo.pio

Dolby Atmos Renderer installer components
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Note: Pro Tools session templates and I/O settings files for setups using the Dolby Audio Bridge
and Dolby Atmos Music Panner plug-ins are included with the Dolby Atmos Music Panner plug-in
installer.

Pro Tools session templates for setups using Send and Return plug-ins
Pro Tools session templates for setups using Send and Return plug-ins are installed in a Pro Tools
session templates folder (~/Documents/Pro Tools/Session Templates/Dolby Atmos
Production Suite).

Template names are based on the system setup and use of mono or stereo plug-ins.

• Dolby Atmos Renderer Send Return Mono.ptxt
• Dolby Atmos Renderer Send Return Stereo.ptxt

Nuendo 10 project templates
The Renderer installer includes Nuendo project templates in respective Nuendo 10 and 10.3 subfolders.

• Nuendo 10: Dolby Atmos Production Suite - 128 channels with LTC_SMPTE.npr is
installed in a Nuendo 10 project templates folder (Users/username/Library/Preferences/
Nuendo 10/Project Templates/Dolby Atmos Production Suite).

• Nuendo 10.3: Dolby Atmos Production Suite - 128 channels with LTC_SMPTE.npr is
installed in a Nuendo 10.3 project templates folder (Users/username/Library/Preferences/
Nuendo 10.3/Project Templates/Dolby Atmos Production Suite).

Nuendo 11 project template
The Nuendo 11 project template (Dolby Atmos Production Suite - 128 channels with
LTC_SMPTE.npr) is installed in a Nuendo 11 project templates folder (Users/username/Library/
Preferences/Nuendo 11/Project Templates/Dolby Atmos Production Suite).

Resolve Studio 17 Fairlight presets
The Renderer installer includes Resolve Studio 17 Fairlight presets for fixed bus and flex bus mapping. These
presets support using the Dolby Atmos Binaural Settings plug-in.

Fixed bus Resolve Fairlight preset
The fixed bus mapping preset is installed in a Blackmagic Design presets folder (Users/username/
Library/Preferences/Blackmagic Design/Davinci Resolve/Fairlight/Presets/
CONSOLE).

• Dolby Atmos 7.1.2 External.dat
Flex bus Resolve Fairlight preset

The flex bus mapping preset is installed in a Blackmagic Design presets folder (Users/username/
Library/Preferences/Blackmagic Design/Davinci Resolve/Fairlight/Presets/
CONSOLE_FLEXI).

• Dolby Atmos 7.1.2 External.dat

3.2.3 Dolby Atmos Binaural Settings plug-in
The Renderer installer includes the Dolby Atmos Binaural Settings plug-in, which provides remote control of
Renderer settings (Binaural Render mode and input configuration) from a DAW session.

The Renderer installer includes the Dolby Atmos Binaural Settings plug-in in three plug-in formats: AAX, AU,
and VST3.

Use the installer to install the plug-in, and plug-in presets and documentation on the computer running the
DAW.

Presets and documentation are automatically installed with the plug-in.

Introduction to the Dolby Atmos Renderer
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Note: You can install the presets and documentation without the plug-in by selecting the option for
all Binaural Settings plug-ins, and then deselecting each Binaural Settings plug-in format. The box for
all plug-ins changes from a plus sign to a minus sign (to indicate that the plug-ins are no longer
included in the install).

When selected, plug-ins are installed to these locations, based on the plug-in format:

• AAX plug-in: /Library/Application Support/Avid/Audio/Plug-Ins
• AU plug-in: /Library/Audio/Plug-Ins/Components
• VST3 plug-in: /Library/Audio/Plug-Ins/VST3
Presets are installed to these locations, based on the plug-in format:

• Avid Audio eXtension (AAX) preset: ~/Documents/Pro Tools/Plug-In Settings/Dolby
Atmos Bina

• AU preset: ~/Library/Audio/Presets/Dolby Laboratories/Dolby Atmos Binaural
Settings

• VST3 preset: ~/Library/Audio/Presets/Dolby Laboratories/Dolby Atmos Binaural
Settings

Documentation is installed to the /Applications/Dolby/Dolby Atmos Binaural Settings
folder.

3.2.4 Dolby LTC Generator plug-in
The Renderer installer includes the Dolby LTC Generator plug-in , which is required for synchronizing the
Renderer to LTC as audio from a DAW.

The Renderer installer includes the Dolby LTC Generator plug-in in three plug-in formats: AAX, AU, and VST3.
Use the installer to install the plug-in on the computer running the DAW.
When selected, plug-ins are installed to these locations, based on the plug-in format:

• AAX plug-in: ~/Library/Application Support/Avid/Audio/Plug-Ins
• AU plug-in: /Library/Audio/Plug-Ins/Components
• VST3 plug-in: /Library/Audio/Plug-Ins/VST3

Dolby Atmos Renderer installer components
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4 
Installing Renderer software

This documentation covers how to install Dolby Atmos Renderer software. For detailed information
about system configurations and installing the renderer and digital audio workstation (DAW) on a
Dolby Atmos system, see the Dolby Atmos Renderer Guide.

• Requirements for a Dolby Atmos Production Suite system
• Requirements for a Dolby Atmos Mastering Suite system
• Activating a Dolby software license
• Installing the Dolby Atmos Renderer on Mac
• Installing the Dolby Atmos Renderer on Windows
• Launching the Dolby Atmos Renderer on a Mac
• Launching the Dolby Atmos Renderer on Windows

Installing Renderer software
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4.1 Requirements for a Dolby Atmos Production Suite system
The Dolby Atmos Renderer with a Dolby Atmos Production Suite license has been tested in multiple
configurations. Tested CPUs, operating systems, and DAWs represent the minimum hardware and software
system requirements for a Dolby Atmos Production Suite system running Renderer v3.7.

Tested CPUs
• MacBook Pro 16,1; Intel Core i9 2.4 GHz, 32 GB random-access memory (RAM)
• MacBook Pro 15,1; Intel Core i7 2.6 GHz, 16 GB RAM
• Mac Pro 7,1; 8-Core Intel Xeon, 3.5 GHz, 32 GB RAM
• Mac Pro 6,1; 6-Core Intel Xeon E5, 3.5 GHz, 32 GB RAM
• Mac mini 8,1; Intel Core i7 3.2 GHz, 16 GB RAM
• Mac mini 9,1; Apple M1, 16 GB RAM (with Rosetta 2)

Tested operating systems
• macOS Big Sur (version 11.4, 11.5)
• macOS Catalina (version 10.15.7)

Tested DAWs
• Ableton Live*

• Live 10.1.9
• Live 10.1.35

• Apple Logic Pro*

• Logic Pro 10.6.2
• Logic Pro 10.4.8

• Avid Pro Tools Ultimate

• Pro Tools Ultimate 2021.6
• Pro Tools Ultimate 2021.3.1
• Pro Tools Ultimate 2020.12

• Resolve Studio 17
• Steinberg Nuendo

• Nuendo 10.3.10
• Nuendo 11.0.20

*Requires the Dolby Atmos Music Panner

4.2 Requirements for a Dolby Atmos Mastering Suite system
The Dolby Atmos Renderer with a Dolby Atmos Mastering Suite license has been tested on Mac and Windows
Dolby Atmos rendering and mastering workstations, and a Renderer Remote on the CPU with Pro Tools.

Rendering and mastering workstations
The Mac and Windows Dell rendering and mastering workstations are dealer-built workstations. Contact your
dealer for ordering details.

Tested Digital Audio Workstations
In a Dolby Atmos Mastering Suite system, the computer running a DAW and the Renderer Remote has been
tested in multiple configurations.

Tested CPUs, operating systems, audio software, and other hardware represent the minimum hardware and
software system requirements for a DAW computer in a Dolby Atmos Mastering Suite system running
Renderer Remote v3.7.

Requirements for a Dolby Atmos Production Suite system
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Tested CPUs

• MacBook Pro 16,1; Intel Core i9 2.4 GHz 32 GB RAM
• MacBook Pro 15,1; Intel Core i7 2.6 GHz 16 GB RAM
• Mac Pro 7,1; 8-Core Intel Xeon, 3.5 GHz, 32 GB RAM
• Mac Pro 6,1; 6-Core Intel Xeon E5, 3.5 GHz, 32 GB RAM
• Mac mini 8,1; Intel Core i7 3.2 GHz 16 GB RAM
• Mac mini 9,1; Apple M1 16 GB RAM (with Rosetta 2)

Tested operating systems

• macOS Big Sur (version 11.4, 11.5)
• macOS Catalina (version 10.15.7)

Tested DAWs

• Avid Pro Tools Ultimate

• Pro Tools Ultimate 2021.6
• Pro Tools Ultimate 2021.3.1
• Pro Tools Ultimate 2020.12

Tested I/O devices

• Avid high definition (HD) MADI
• Avid MTRX
• Avid MTRX Studio
• Avid Sync HD
• AVIO 2x0 Analog Input Adapter for the LTC over audio
• Focusrite Dante HD32
• Focusrite Dante D64R
• Focusrite X2P for the LTC over audio

Tested chassis

• Avid Pro Tools HDX TB3 Rack
• Sonnet xMac Pro Server PCIe 2.0 Thunderbolt 2
• Sonnet Echo III-D Chassis

4.3 Activating a Dolby software license
On a supported computer or iLok, activate the license that enables your software. We recommend that you
activate the license before you install the software.

Prerequisites

• Download and install the iLok License Manager from www.ilok.com.
• Ensure that you have iLok authorization for the license.

About this task

This task is performed in the iLok License Manager.

Procedure

1. Launch the iLok License Manager.
2. In the iLok License Manager window, sign in to your account, and then click (highlight) your account

name in the navigation bar.

Your account name is shown in the upper-left panel. Your host machine and iLok Universal Serial Bus
(USB) devices are shown as icons in the panel below your account information.

3. Click the Available tab in the iLok License Manager header.

Installing Renderer software
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Figure 12: Available tab in iLok License Manager

If you do not see the Available tab, widen the application window until the tab is visible in the header.
The available licenses are shown under the tabs.

4. Locate the license for your software, and then drag and drop it to your host machine icon or to the iLok
device icon on the left.

5. Follow any additional onscreen instructions.
6. In the iLok License Manager window, repeat these steps if you are installing additional licenses to other

machines or iLoks.

4.4 Installing the Dolby Atmos Renderer on Mac
Depending on your system setup, install the Dolby Atmos Renderer components on the Mac that is running
your DAW, on a Mac rendering and mastering workstation, or both.

Prerequisites

• Ensure that the machine meets system requirements, including any required software. (See the
Dolby Atmos Renderer Guide  or Dolby Atmos Renderer Release Notes .)

• Ensure that you have activated the license for your software.

About this task

• When selecting which components to install, select the components that are required for your system
configuration.

• The installer also includes optional components (such as the Dolby Audio Bridge, plug-ins,
documentation, and templates). Choose optional components based on your Dolby Atmos Renderer
configuration and needs.

• When updating the Renderer or Renderer Remote software, the existing Renderer system settings are
automatically backed up as an .atmoscfg file that is saved on your local drive (/Users/username/
Library/Application Support/Dolby/Dolby Atmos Renderer/Backups).

Procedure

1. If you are updating the Dolby Atmos Renderer and supporting software, ensure that the Dolby Atmos
Renderer is not running.

2. Double-click the Dolby Atmos Renderer .dmg file (Dolby_Atmos_Renderer-3.x.x-
xxxxxxx.dmg).
This file provides access to the installer and documentation. Refer to the documentation for what is new
in this version of the Renderer, release notes (including known issues), and additional information.

3. Double-click the Dolby Atmos Renderer installer package (Dolby Atmos Renderer.pkg).
4. Follow the onscreen instructions.
5. When prompted to select which components to install, select the components required for your system

configuration, and then click Continue.

Installing the Dolby Atmos Renderer on Mac
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Figure 13: Default Installation Type page of the Install Dolby Atmos Renderer dialog

Note: For entries that have a reveal triangle (Dolby Atmos Binaural Settings Plug-in, Dolby LTC
Generator Plug-in v2.0, and DAW Templates), you can click the triangle to show individual items
that can be included or excluded with the install.

Installing Renderer software
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Note: You can click on an item in the Package Name column to reveal information about the
package.

6. Complete installation.
7. If prompted for permission for the Renderer to access the Mac microphone, click OK.

Note: Using the Renderer with the bridge requires access to the Mac microphone to pass audio
into or out of the Renderer.

If you do not click OK at this time, you can provide permission via System Preferences.

a. In System Preferences, choose Security & Privacy.
b. Click the Privacy tab.
c. Select Microphone in the sidebar.
d. On the right side of the window, select (enable) Dolby Atmos Renderer.

Results
All items selected for installation are installed.

4.5 Installing the Dolby Atmos Renderer on Windows
Install the Dolby Atmos Renderer on a Dolby Atmos rendering and mastering workstation running on
Windows.

Prerequisites

• Ensure that the machine meets system requirements, including any required software. This includes
updated drivers.

• Ensure that you have activated the Dolby Atmos Mastering Suite license.
• When updating Renderer or Renderer Remote software, the existing Renderer system settings are

automatically backed up as an .atmoscfg file, which is saved to C:\ProgramData\Dolby\Dolby
Atmos Renderer\Backups.

Installing the Dolby Atmos Renderer on Windows
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About this task

When selecting which components to install, select the components that are required for your system
configuration.

The installer also includes optional components (such as documentation). Choose optional components
based on your Dolby Atmos Renderer configuration and needs.

Installation includes a restart of Windows.

Procedure

1. If updating Dolby Atmos Renderer and supporting software, ensure that the Dolby Atmos Renderer is not
running.

2. Double-click the Dolby Atmos Renderer .zip file (Dolby_Atmos_Renderer-3.x.x-
xxxxxxx.zip).
This provides access to the installer and documentation. Refer to documentation for what is new in this
version, release notes (including known issues), and additional information.

3. Double-click the Dolby Atmos Renderer installer executable (Dolby Atmos Renderer.exe).
4. Follow the onscreen instructions.

5. Complete installation.
6. Set Performance options to Programs:

a. Navigate to Control Panel > System & Security > System > Advanced System Settings > Advanced.
b. In Performance Options, click on the Settings button, select the Advanced tab, and under Processor

scheduling, choose Adjust best performance of: Programs.

4.6 Launching the Dolby Atmos Renderer on a Mac
After Dolby Atmos Renderer software is installed, you can launch the Renderer.

Prerequisites
Download and install the iLok License Manager from www.ilok.com.

Installing Renderer software
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About this task

You can perform this task with the Dolby Atmos Renderer using a Production Suite or Mastering Suite license.
Depending on your system configuration, the Renderer will be on the computer running your DAW or on a
Dolby Atmos rendering and mastering workstation.

Procedure

1. Locate the Dolby Atmos Renderer application name or icon.

The Dolby Atmos Renderer application is in the Applications/Dolby/Dolby Atmos Renderer
folder.

Dolby Atmos Renderer icon:

2. Double-click the Dolby Atmos Renderer application name, or click the icon in the dock.

Results

The Dolby Atmos Renderer window displays.

Launching the Dolby Atmos Renderer on a Mac
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4.7 Launching the Dolby Atmos Renderer on Windows
Launch the Dolby Atmos Renderer application on a Dolby Atmos rendering and mastering workstation
running Windows after completing the prerequisites for launching the application.

Prerequisites

• Download and install the iLok License Manager from www.ilok.com.
• To run Renderer v3.x on a Windows rendering and mastering workstation that has an older Renderer

version installed on it, you must change workstation settings before installing and launching Dolby Atmos
Renderer v3.x. The new settings will ensure that older Renderer software versions do not launch on
restart.

About this task

You can perform this task with the Dolby Atmos Renderer using a Production Suite or Mastering Suite license.

Procedure

1. Locate the Dolby Atmos Renderer application name or icon.

The Dolby Atmos Renderer application is in the C:\Program Files (x86)\Dolby\Dolby Atmos
Renderer folder.

Dolby Atmos Renderer icon

2. Click the Dolby Atmos Renderer application name or icon.

The Dolby Atmos Renderer window displays.

Installing Renderer software
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5 
Previous releases

This version of Dolby Atmos Renderer includes new features, improvements, and fixes, plus updates
included in previous versions.

• New in version 3.5
• New in version 3.4
• New in version 3.3
• New in version 3.2
• New in version 3.0.2
• New in version 3.0.1

Previous releases
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5.1 New in version 3.5
Dolby Atmos Renderer v3.5 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

Operation improvements
• Improved binaural renderer with increased spatial resolution.
• Standard group names for configuring input and re-renders, based on postproduction standard stem

names: Dialog, Music, Effects, and Narration.

These groups are available here:

• Input configuration window, in the Group drop-down selector
• Custom list of groups, in the Re-render properties window

Note: You can still add custom groups.

• Standard groups can be shown in the objects view.

1. Click the small box icon drop-down menu in the top-right corner of the objects view to reveal the View
and Show options.

2. In the Show section, click (highlight) Standard groups.
• MP4 export in film encoding mode now supports two different bit rates to provide parity with various

streaming platforms during QC:

• 768 kbps: This is the same bit rate as the music encoding mode.
• 448 kbps: This is the bit rate that was used for film in previous versions of the Renderer.

These bit rates are selectable via a drop-down menu in the Export master to .mp4 window.
• Option to export re-renders as multi-mono files without channel numbers in the file names. This is useful

when importing re-renders into an application that groups multi-mono files by matching file names.
• Dolby Atmos .atmos masters created with v3.5 no longer include a .dbmd file. Older masters with

a .dbmd file are supported and can be imported for playback or editing. The .dbmd file is no longer
necessary for Dolby Atmos files to play correctly and will be removed from older files on unlocking.

• Loudness measurements reset automatically when a master is closed.
• Binaural re-renders now have BIN appended to the file name, and they can be exported as both multi-

mono and interleaved files.
• The default number of elements (spatial coding clusters) is now 14 instead of 12.

Input configuration and Binaural Render mode settings improvements
• Support for the Dolby Atmos Binaural Settings plug-in.

This plug-in provides remote control of Renderer settings (Binaural Render mode and input
configuration) from a digital audio workstation (DAW) session.

When the plug-in is connected to the Renderer, you can use the plug-in to modify input configuration and
Binaural Render mode settings in these Dolby Atmos workflows:

• Monitoring a mix
• Writing plug-in settings to a new master
• Copying Binaural Render mode settings from the plug-in to the master
• Copying groups from the plug-in to the master

Alternatively, you can change all plug-in settings by importing a preset using your DAW plug-in controls,
or by copying settings from a Renderer master.

• New workflows for displaying or changing input configuration and Binaural Render mode settings.

The Input configuration and Binaural Render mode windows now have Input and Master tabs to open
pages where you can edit settings on the input to the Renderer or settings in opened and unlocked
master files, respectively. Settings in the input, or an open and unlocked master, can be edited locally, or
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via the Dolby Atmos Binaural Settings plug-in. Changes made in the plug-in can then be transferred to an
open and unlocked master.

A new master will always use the input settings. When an existing master is opened, the input settings are
unavailable until the master file is closed. Settings made in the input are temporarily hidden when you
open a master, but they are available again when you close the master.

• The File menu for exporting input configurations, Binaural Render mode, and re-render configurations
indicates that, if you have a master loaded, you will be exporting the settings contained within that
master. With no master loaded, you will be exporting the settings currently in the Renderer.

When a master is opened, the Export Input/Binaural/Re-render Config file menu automatically changes
to Export Master Input/Binaural/Re-render Config.

To export the configurations for a master, choose File > Export Master Input/Binaural/Re-render
Config.

Renderer window and other UI updates
• General look of user interface (UI) improved, including the addition of the new Dolby logo.
• New Dolby Atmos Renderer application icon.

• The ability to expand or collapse object view (the virtual 3D room) is now toggled from inside the object
view frame, using the expand/collapse icon.

Previously, you would use the All and Objects view control buttons. These buttons have been removed
from the Renderer window.

• Status and error message section and the central processing unit (CPU) section have been moved to the
bottom of the main UI. The new bottom section also includes a connection status (for external remote
controller clients) section.

• Input and Master buttons in the Source section are now located left and right for better display and
accessibility.

• Network information preferences renamed to Remote clients and now provides more information.

The upper part of this preferences page displays Renderer IP addresses. Use any of these addresses to
connect a Dolby Atmos Renderer Remote application or remote controller client (such as the Dolby Atmos
Binaural Settings plug-in) to the Renderer.

Below the addresses, the page displays Renderer Remote applications that are connected to the
Renderer, and then a table that lists any connected remote controller clients.

For remote controller clients, this information is provided: Client type, IP Address, User description,
and Controlling (which lists the settings and channels, if applicable, which the client is controlling).

• Direct Render with Warp downmix option renamed to the more descriptive Direct Render with room
balance.

The downmix algorithm has not been changed. This option is available in the 5.1 downmix in master
and 5.1 downmix monitoring/re-renderers drop-down menus, located in the Trim and downmix
controls window.

• 5.1 trim controls renamed to 5.1 and 2.0, as adjusting these settings affects both the 5.1 and stereo
downmixes.

• Stereo direct removed from monitoring options in the Trim and downmix controls window.

New in version 3.5
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New keyboard shortcuts

Table 2: File menu shortcuts

Menu Mac keyboard shortcut Windows keyboard shortcut

Import Input/Binaural/Re-render
Config

Option + Shift + I Alt + Shift + I

Export Input/Binaural/Re-render
Config (or Export Master Input/
Binaural/Re-render Config)

Option + Shift + E Ctrl + Shift + E

Table 3: System menu shortcuts

Menu Mac keyboard shortcut Windows keyboard shortcut

Import Settings Option + Cmd + I Alt + Ctrl + I

Export Settings Option + Cmd + E Alt + Ctrl + E

Table 4: Renderer window shortcuts

Menu Mac keyboard shortcut Windows keyboard shortcut

Input/master toggle Shift + I Shift + I

Record arm/disarm Shift + R Shift + R

External sync engage/disengage Shift + J Shift + J

Dim Shift + D Shift + D

Mute all Shift + M Shift + M

Attenuation change by +1 dB Shift + Up Arrow Shift + Up Arrow

Attenuation change by -1 dB Shift + Down Arrow Shift + Down Arrow

Reset attenuation to 0 dB Cmd + Shift + U Shift + Ctrl + U

Reset loudness Shift + L Shift + L

5.2 New in version 3.4
Dolby Atmos Renderer v3.4 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

Real-time loudness when monitoring a Dolby Atmos mix
The Renderer provides real-time loudness measurements and metering when monitoring input or playing
back a master file.

Loudness meters, controls, and measurements in the main window
When the Loudness measurement preference is on (as set in the Loudness preferences), the main window
includes loudness meters, controls, and measurement information. By default, the preference is on.

Measuring the loudness of a master offline
You can measure the loudness of a master or section of a master offline. After measuring the loudness, you
can then export the loudness measurements for Dolby Atmos or Stereo/Binaural as a timeline (.csv file) or
summary (.txt file).
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Considerations when measuring loudness
• Ensure that downmix settings in the master are the same as the monitoring settings: Loudness settings

are affected by the downmix monitoring settings in the Trim and downmix control window. To ensure
that the settings measured are those written in the master, click the link icons for 5.1 downmix
monitoring/re-renders and 5.1 to stereo downmix monitoring/re-renders so that the monitoring
settings match the respective downmix in master settings, and then do the loudness measurement.

• Differences between real time and offline rendering: There can be slight differences between real time
and offline loudness measurements due to buffering and speech percentage calculations. The offline
calculations are always more accurate.

New re-render options: 5.1.2, 7.1.4, and Loudness
The re-render output matrix includes three new layouts: 5.1.2, 7.1.4, and Loudness. These layouts are
available when you create and map a re-render while configuring the re-render output matrix. The layouts
appear as options in the Layout drop-down menus in the Re-renders and Properties windows.

Use the Loudness layout (which is a 5.1 layout) for loudness measurements. For example, run the loudness
re-render into the DAW if using an external loudness plug-in. This will be more accurate than running a
standard 5.1 re-render into an external plug-in.

Limiting on output and re-renders
Processing preferences includes an option for turning on output limiting.

When the Output limiting option is on, the Renderer applies soft clip limiter to speaker monitoring,
headphone monitoring, and re-renders.

Group improvements
After a master is created, you can now manage and reassign groups.

• In the Groups window, you can add, rename, or delete a group.
• In the Input configuration window, you can change the group assignment for any bed.

Display of object numbers or binaural distance model settings of objects in objects
view
In the objects view, you can display numbers for each object or the binaural distance model settings (off,
near, mid, and far) for each input object.

Note: The binaural distance model settings are defined in the Binaural Render mode window.

Aligning timecode to audio
You can add offset to timecode (in samples) to better align timecode to audio if routing timecode through a
different A/D converter to your audio. You access these controls via the new Advanced Settings menu and
Audio to Timecode Alignment submenu.

Note: If you are using Dolby Atmos Production Suite on an in-the-box workflow you, or Dolby Atmos
Mastering Suite in a two-machine setup using qualified hardware, you will not need to adjust these
advanced settings.

LTC Generator plug-in, for sending LTC over audio from Pro Tools to the Renderer
The Renderer installer now includes the Dolby LTC Generator plug-in, which is used for sending LTC over
audio from Pro Tools to the Renderer on systems using the Dolby Audio Bridge. (With Renderer v3.7, version
2.0 of the plug-in is included in Pro Tools templates.)

New in version 3.4
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Trims and downmix controls included with the Production Suite
The Production Suite now includes the ability to write the trim and downmix settings to a master file. These
are available in the Trims and downmix controls window (accessible via Windows > Trim and Downmix
Controls).

Use the trims and downmix controls for:

• Writing downmix metadata in a master
• Writing trim metadata in a master

Additional improvements and changes
• The 5.1 and stereo downmix type written to the master in downmix settings, as well as the trims settings

are now included in the MP4 export.

This means that the MP4 export can be used to monitor the mix on a Dolby Atmos enabled system, or a
5.1 or stereo system.

• Descriptions for beds and objects (as defined in the Input configuration window) are now also shown in
the Binaural Render mode window.

• In the Binaural Render mode window, Backwards Compatibility mode settings have been removed.
You can now always write metadata for beds and objects in this window.

• A limiter in the Low-Frequency Effects (LFE) with a -10 dB threshold has been removed.

Note: When calibrating your room, the LFE should still be calibrated at +10 dB in accordance with
standard 5.1 and Dolby Atmos requirements.

5.3 New in version 3.3
Dolby Atmos Renderer v3.3 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

• Ability to export to MP4 file format
• Improved binaural headphone monitoring

Size information and LFE signal is now included in the binaural output.
• Binaural Render mode updates

• Ability to import or export Binaural Render mode configurations, via the Import Input/Binaural/Re-
render Config and Export Input/Binaural/Re-render Config menu commands and dialog.

The Import input/binaural/re-renders configuration file dialog includes options to import
configurations for input only, input and Binaural Render mode, and re-renders.

• In the Binaural Render mode window, all LFE channels are now set to Off and cannot be changed.
This includes masters created with Renderer v3.2 that were saved with the LFE channel not set to Off.

• Changes to stereo downmix settings

The preferred stereo downmix type can now be written into the master file using Dolby Atmos Mastering
Suite.

• New view options for objects view

Click the small box icon drop-down menu in the top right corner of the objects view to reveal options.
Click on an option to select it.

View options include:

• Theater: This view is the same as the view provided in earlier versions of Renderer v3.x. In this view,
objects use the full room, with zero height being shown at floor level. Additionally, the front of the
room includes a white screen.

• Person: This view includes a representation of a listener in the center of the room. Objects at zero
height appear at the ear level of the listener.

Previous releases
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Show option includes:

• Object number: When selected, the object number for each object in the room is displayed below the
object. This option is supported in theater or person view.

• Headphone output updates.

Headphone limiter now applies to the binaural headphone output only. The stereo headphone output
now clips at zero to simulate the real clip level.

• Changes to Pro Tools templates included with the installer.

• Pro Tools session templates for setups using Send and Return plug-ins have been updated and
renamed. Template names are based on the system setup and use of mono or stereo plug-ins.

• For Pro Tools setups that use the Dolby Audio Bridge, Pro Tools session templates have been updated
and renamed, and the installer includes Pro Tools input/output (I/O) .pio settings files. Template
and settings file names are based on the system setup and use of mono or stereo plug-ins.

5.4 New in version 3.2
Dolby Atmos Renderer v3.2 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

• Ability to open and export IMF immersive audio bitstream (IAB) .mxf files.
• Array mode (Dolby Atmos Mastering Suite):

• Enables Home Theater content to be created in rooms that have small speaker arrays. This mode can
be activated in the Room Setup window.

• Includes control of equalization (EQ), delays, and gains of arrays (when in Array mode)
• Downmix settings: The 5.1 downmix type is now contained within the master. It can be written using

Dolby Atmos Mastering Suite or read by both Dolby Atmos Mastering Suite and Dolby Atmos Production
Suite.

• Improvements to overall performance and CPU usage.
• Smoother transitions between monitoring options.
• Headphone limiter: A limiter is applied to the headphone output. Limiting affects monitoring (at the

spatial coding output prior to rendering to speakers), and it is also applied to binaural re-renders.
• System settings automatically backed up when upgrading from previous versions of the Renderer.

Settings are backed up as an .atmoscfg file that is saved on your local drive.
• VR mode removed.

VR mode, VR panner plug-ins, and the VR transcoder have been removed from the Dolby Atmos Renderer.
• Playing back DAW audio from the Speaker calibration window:

External signal fed into the Renderer can play back while applying gain, delay, or EQ in the Speaker
calibration window. In previous versions of the Renderer, external audio would be muted when the
Speaker calibration window was open.

5.5 New in version 3.0.2
Dolby Atmos Renderer v3.0.2 includes new features, improvements, and fixes for using Dolby Atmos
Renderer software to author content in Dolby Atmos.

• Supports control of level, mutes, and dims via an Avid System 5 digital audio system.
• Binaural rendering performance at 96 kHz improved.
• Improved trim functionality (Dolby Atmos Mastering Suite only).
• Room EQ can now be used to set bass managed speakers (Dolby Atmos Mastering Suite only).

New in version 3.2
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5.6 New in version 3.0.1
Dolby Atmos Renderer v3.0.1 includes new features, improvements, and fixes for using Dolby Atmos
Renderer software to author content in Dolby Atmos.

• Ability to automatically number object descriptions sequentially (in the Input configuration dialog
Description column).

• In the Record in/out section, ability to use the Tab key to move the cursor between the In point and Out
point settings.

• Improved re-render naming when creating re-renders offline (with File > Export Re-renders).

Each mono .wav file is now named with the channel number and then the channel type at the end of the
file name (before .wav). This better prepares the files for importing into a DAW.

The naming convention for an exported re-render .wav file is <export_file_name>_<re-
render_name>_<channel_number>.<channel_type>.wav.

• Exported re-renders time-stamped in accordance with the Broadcast Wave Format (BWF) format
standard.

Each re-render .wav file is time-stamped with the start time. This lets you import the files into a DAW and
have them appear in the correct position on the timeline.

• Ability to export re-renders as interleaved multichannel .wav files.
• Access to log information via the Open Logs Folder command in the Help menu.

Previous releases
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6 
Known issues

This release has some known issues, for which we provide workarounds, comments, and solutions.

Installation
• If you install Dolby Atmos Renderer v3.7 beta on Windows while a previous version of the Renderer

is open, the previous version remains open during installation, and becomes unusable after the
new installation is complete. As a workaround, close the older version before the installation, or
close the older version after installation, and then restart the Renderer. [PRAU-2681]

• Older versions of the Dolby Atmos Renderer Remote application will not connect to newer versions
of the Dolby Atmos Renderer. Install both the Renderer and Remote applications from the same
installer. [DACT-8989]

• When using Remote Desktop to manage installation of the Renderer on a Mac rendering and
mastering workstation, the Dolby Audio Bridge will not successfully install on the workstation. As a
workaround, install the Dolby Audio Bridge directly on the workstation. [DACT-7721]

• The Dolby Atmos Panner plug-in was removed from the Dolby Atmos Renderer installer with v3.4
and is not supported with Renderer v3.4 and later running on macOS Catalina. As a workaround,
use the object panners included with Pro Tools, or the Dolby Atmos Music Panner (available from
Dolby). Alternatively, you can use the Dolby Atmos Panner included with Renderer v3.3 and earlier
on supported versions of macOS Mojave and High Sierra. [PRAU-1200]

• Aggregate device workflows cannot be used with Dolby Audio Bridge v1 and the RME MADIface XT
USB 3.0. As a workaround, use Dolby Audio Bridge v2.0, which does not require the aggregate
device workflow. [PRAU-3169]

Playing back, recording, or exporting audio
• If the Core Audio input device or Core Audio output device is set to None, or if the field is empty,

when Core Audio is the active audio driver for the Renderer, an Audio driver error message
displays and the Renderer is not fully operational. Set the devices to available choices other than
None to make the Renderer fully operational. [PRAU-58]

• If you change the Audio driver setting (in Driver preferences) from None or Send/Return plug-ins
to Core Audio after creating a master file, the record button disables due to a panner mismatch.
[PRAU-2820], [PRAU-2620]

• Connecting an audio device to your system while the Renderer is running may change the device
audio settings in your system. This can result in audio drops due to an invalid system setup, and
produce a log error (ERROR RendererExecutive audio device processor
overload). If this occurs, check the settings for the Audio Driver Configuration in the Renderer
and the Mac Audio MIDI Setup. If the settings are not correct, update them. [DACT-6280]

• Connecting or disconnecting headphones while the Renderer is running and using the Core Audio
built-in output causes an audio driver error. This occurs because the macOS system changes the
device audio configuration. As a workaround, reinitialize the Renderer to reconfigure the Core
Audio driver. For example, choose Dolby Atmos Renderer > Preferences, and then click Accept.
[DACT-7902]

• Switching directly from muting all audio with the Mute button, to momentarily unmuting either the
beds or objects (via the Beds or Objects mute buttons, respectively) briefly unmutes all audio
before applying the active mute. [PRAU-2232]

• If an object is reassigned when signal is present, the signal may appear present in the previous
object. As a workaround, do not reassign objects while playing audio. [PRAU-1016]
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• When the Renderer and digital audio workstation (DAW) frame rate do not match, a warning
message does not appear when External sync source is set to ASIO. As a workaround, manually
check that the workflow is performing correctly. [PRAU-2822]

• When in Array mode, the output meters in the main Renderer window are post B-chain gain and
equalization (EQ). [PRAU-141]

• Playing back a master file from an external optical drive can result in undesired artifacts or glitches
when monitoring. As a workaround, open the master file from a fast SSD drive or from the internal
drive of the Renderer machine. [PRAU-150]

• If master file content is present at the offset start time, playback without preroll may result in the
loss of the first buffer. To avoid this, always start playback with at least one frame of preroll. For
optimum performance, We recommend preroll and postroll of greater than two frames for playback
and recording. [PRAU-149]

• When two machines are connected to the Renderer and the Renderer is recording audio and
metadata from a Pro Tools session on the first machine, opening a Dolby Atmos Pro Tools session
on the second machine that has object panners enabled on object IDs that are being recorded to by
the Renderer will send metadata to the Renderer and overwrite metadata in the session on the first
machine. This can produce unwanted recorded data.[PRAU-109]

• The Renderer can intermittently stop recording when using an Apple M1 computer with a qualified
external sound device in either an out-of-the box or rendering and mastering workstation workflow.
This primarily occurs with large sessions with lots of metadata. [PRAU-3174]

• Recording a master file over a network hard disk drive (HDD) is not supported. The recording
process will be stopped due to disk underruns produced by low transfer rates. [PRAU-67]

• The oversampling functionality in some plug-ins can cause timecode discontinuities in the Dolby
LTC Generator plug-in. This can result in the Renderer dropping out of record. [PRAU-1240]

• When working with Pro Tools at a frame rate higher than 30 fps, the Dolby LTC Generator plug-in
functions at a maximum of 30 fps. [EUROPA-1975]

• Before beginning the workflow to record a master using set in and out points, ensure that the DAW
session is open. If you set up the Renderer for recording, and then open a DAW session that has an
input configuration conflict with the Renderer, the Renderer will disarm the master when the in
point is reached and not provide any warning that this has occurred. [PRAU-74]

• Pro Tools offline bounce is not supported with the Dolby Atmos Renderer. Attempting an offline
bounce on Pro Tools HDX systems can cause a crash. Attempting an offline bounce on a Pro Tools
native system can cause significant metadata loss. [DACT-6053], [DACT-5743]

• The Pro Tools scrubber tool is not supported when monitoring a Dolby Atmos master file. [PRAU-96]
• Pro Tools aggregate and built-in output audio devices can intermittently, and without warning,

change the sampling rate to 44.1 kHz (typically, after a central processing unit (CPU) overload). This
sample-rate change causes rendered audio to be jittery. As a workaround, open the Mac Audio MIDI
Setup application and select the 48 kHz sample rate. If 48 kHz is already selected, unselect it, and
then reselect it. [DACT-5484]

• If a Dolby Atmos Pro Tools session connected to a Renderer using the Send/Return plug-ins audio
driver is closed, the associated input channels in the Renderer remain active. To clear the meters,
reinitialize the Renderer (for example, by closing the Renderer and relaunching it). [PRAU-121]

• Loudness meter data cannot be cleared when the Send/Return driver is selected and no send or
return plug-ins are inserted in the Pro Tools session. [PRAU-1025]

• When using the Send/Return plug-ins audio driver, ensure that the Pro Tools transport stops after
the recording end time. This ensures that the final master does not have any missing samples at the
end time. [PRAU-94]

• When using the Send/Return plug-ins driver, the Pro Tools preroll feature does not work. Instead,
the Renderer will start chasing linear timecode (LTC) when the preroll period has ended.
[DACT-8026]

• When the Renderer input configuration is modified, and this results in a panner object assignment
in the open DAW session now pointing to a bed input channel, the Renderer displays an error
message. With v3.7 beta, there is no longer an error message. [PRAU-2450]

• When 5.1 and 7.1 or 7.1.2 beds are used in the same input configuration, the Binaural Render mode
settings in the Ls and Rs channels of a 5.1 bed and the Lrs/Rrs and Lss/Rss channels of any 7.1 and
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7.1.2 beds can affect each other, with one of the settings overwriting the other. As a workaround, do
not use 5.1 beds and 7.1 or 7.1.2 beds in the same input configuration. [PRAU-1971]

• Zone masking metadata is disabled when spatial coding emulation and snap metadata are active at
the same time. [PRAU-2653]

• When the 5.1 downmix is set to Standard (Left only/Right only (Lo/Ro)) or Dolby Pro Logic IIx, and
spatial coding emulation is off, object size is not applied. [PRAU-85]

• When the hard drive used to export audio does not have enough space, the export will complete
with an Export successful message even though the exported audio will be incomplete and cannot
be used. [PRAU-86]

Master files and re-renders
• An .atmos master file set that has naming differences between the .atmos, .audio,

and .metadata files will be corrupted on editing. [PRAU-114]
• If the MP4 master file name has two or more successive commas (for example ",,,"), it will

produce an export error. As a workaround, use a maximum of one comma in a file name.
[PRAU-1147]

• If you create a file in Windows that starts with a period, and then try to use it on Mac, the file will be
hidden.

• When exporting re-renders to an external drive, if the drive is unplugged during the export, the
export will continue and report a successful operation even if the re-renders were not successfully
written to the drive. As a workaround, do not unplug the destination drive when exporting re-
renders. [PRAU-153]

• Cinema Renderer settings containing 12.1 re-renders cannot be imported into Renderer v3.4 and
later. As a workaround, remove the 12.1 re-renders using the Cinema Renderer before importing the
settings. [PRAU-1189]

• AmbiX re-renders do not export as multiple-mono files. As a workaround, export these as
interleaved, and then use third-party software to separate the files. [PRAU-1956]

• Attempting to use a read-only directory to export re-renders, export an Audio Definition Model
(ADM) Broadcast Wave Format (BWF) .wav file, or create a new master does not provide a
descriptive error to the Dolby Atmos Renderer Remote application. Instead, the error simply notes
that the file was not written. As a workaround, choose a destination directory that is not read only.
[PRAU-65]

Renderer launch and connections
• When localhost is used as the IP address to connect to a Renderer, a double colon (::) displays in

the Network information page of the Preferences window. As a workaround, use a valid IP
address. [PRAU-61]

• If the Dolby Atmos Renderer Remote application is launched before the Dolby Atmos Renderer, the
remote will not autoconnect to the Renderer. As a workaround, connect the Renderer Remote to the
rendering and mastering workstation using the IP address drop-down menu, or launch the Remote
after launching the Renderer. [DACT-8012]

• The Renderer can hang at launch after upgrading to Catalina 10.15.6 if the iLok with the Renderer
asset is plugged in a powered USB hub. As a workaround, unplug the iLok and reconnect it, and
then relaunch the Renderer. [PRAU-1998]

• In Windows, the Renderer will fail to initialize if you open the Renderer with a previously loaded
master from an encrypted drive that has not been unlocked. As a workaround, make sure the drive
has been unlocked before launching the Renderer. Alternatively, close the master before closing the
Renderer to avoid reloading the master upon launch. [DACT-8099]

• For systems with a dual-boot rendering and mastering workstation, Cinema Renderer services have
to be closed to use the Home Theater Renderer running with a Dolby Atmos Mastering Suite license,
and vice versa. [PRAU-589]

• The Renderer can disconnect from the DAW with sessions that use the Dolby Atmos Music Panner
and have high channel counts and excessive Dolby Atmos metadata. [PRAU-980], [PRAU-998]
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• Communication issues between Pro Tools and the Renderer may occur on Mac Pro 6,1 and other
older Apple computers running macOS Big Sur. These issues are more likely to occur with sessions
that have lots of metadata. [PRAU-2702]

• In Pro Tools 2020.12 and 2021.3, connecting to the Rendering and Mastering Unit (RMU) Host in the
Peripherals window by typing the Renderer IP address limits the Dolby Audio Bridge to 32 channels.
[PRAU-2732]

• For setups with Pro Tools 2019.12 with the LTC Generator plug-in, the plug-in will not work until you
manually set the frame rate in Pro Tools. [PRAU-1801]

• A Dolby Atmos .atmosIR configuration file with special characters in the file name may cause
errors on import. As a workaround, do not use special characters with an .atmosIR configuration
file. [PRAU-736]

• Resetting the Renderer to the factory default does not reset the loudness user interface (UI). As a
workaround, click the loudness reset button, perform a factory reset, and then restart the Renderer.
[PRAU-1127]

• In the Speaker calibration window, you can enter decimal values in the delay fields. When you press
Accept, the values round to the nearest integer value. [PRAU-2673]

• In the Speaker calibration window, if a gain or delay value is changed by entering a number in the
field and then pressing the Return key, the Up/Down arrows in that field, as well as the Command +
Up/Down arrows keyboard shortcut, no longer function in that field. [PRAU-2435]
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Glossary
.wav

Waveform Audio Format. An audio bitstream file format.

AAX
Avid Audio eXtension. A plug-in format for Avid Pro Tools.

ADM
Audio Definition Model. A metadata model specified in ITU.R.BS.2076 that describes channel-, object-, or
scene-based audio file formats.

ASIO
Audio Stream Input/Output. A soundcard driver protocol from Steinberg Media Technologies GmbH that
allows musicians and sound engineers to access PC soundcards directly without going through Microsoft
Windows.

audio driver

A software system that processes audio input signals by transforming them into a format that audio
devices, such as speakers and headphones, can output.

BWF
Broadcast Wave Format. An extension of the Microsoft Waveform Audio Format (.wav) file format to
include metadata important to broadcast applications. This format is specified in EBU Tech 3285.

B-format
A speaker-independent representation of a soundfield.

CPU
Central processing unit.

DAW
Digital audio workstation. An electronic device or computer software application used to record, edit,
and produce audio files.

Dolby RMU
Dolby Rendering and Mastering Unit.

downmix

Process of producing a device-specific output mix when the number of process channels is greater than
the number of output speakers on the device.

EQ
Equalization. The adjustment of audio frequency responses for practical or aesthetic reasons.

frame
In audio, a series of PCM samples or encoded audio data representing the same time interval for all
channels in the configuration. Metadata pertaining to the frame can be carried within the frame or
separately, depending on context.

frame rate
The number of frames decoded per second in real-time operation.
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HD
High definition.

HTML
HyperText Markup Language.

I/O
Input/output. The communication between a system and an entity outside the system, such as another
system or a human being.

IMF
Interoperable Master Format. A SMPTE standard that defines an interoperable, file-based framework
designed to facilitate the management and processing of multiple versions of the same high-quality
finished work. See SMPTE ST 2067-2 and related documentation.

IP address
Internet Protocol address. A numerical identifier assigned to a device that is a member of a network that
uses the IP for communication.

LFE
Low-Frequency Effects. A band-limited channel specifically intended for deep, low-pitched sounds.

Lo/Ro
Left only/Right only. A stereo representation that preserves separation of Left Surround and Right
Surround channels in conversion from a surround format, and is also mono compatible.

LTC
Linear timecode. A timecode developed by the Society of Motion Picture and Television Engineers
(SMPTE) that provides a time reference for editing, synchronization, and identification.

MADI
Multichannel Audio Digital Interface. A communications protocol for an interface that carries multiple
channels of digital audio, defined by the Audio Engineering Society. Also known as AES10.

MP4
A digital multimedia container format defined in MPEG-4 (ISO/IEC-14496, parts 12 and 14) most
commonly used to store video and audio streams.

object
An audio signal plus associated object audio metadata.

PC
Personal computer.

RAM
Random-access memory.

rendering
Processing of audio content to adapt it to specific speaker layouts, such as 5.1- and 7.1-speaker feeds, or
headphones and sound bars.

RMU
Rendering and Mastering Unit.
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UI
User interface.

USB
Universal Serial Bus. A standard that defines the cables, connectors, and communications protocols
used in connections between computers and electronic devices.
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